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Chapter 11:  The Patient Set Editor 

A “Patient Set” stores all data for the patient.  These include patient demographic data and data 
related to each cancer diagnosis. Consolidated data are stored in Patient Set fields.  The source 
data that contributed the data are “linked” to the Patient Set. The Patient Set Editor provides 
access to the consolidated and source data. Source data include abstracts, path reports, death 
certificate records, and records based on linkages; as well as pharmacy data, claims data, and 
physician reports.  Refer to Chapter 2 for a description of the Patient Set data structure.  

Two users may open the same Patient Set in the editor at the same time, but only one user will be 
able to make changes.  SEER*DMS implements a lock when the first user opens a Patient Set in 
the editor. A warning message is displayed if you open a Patient Set that another user is editing. 

The features of the Patient Set editor are described in this chapter.  Task-specific instructions are 
provided in Chapter 12:  Consolidating Data and Chapter 14:  Resolving Patient Set Errors.   

In this chapter, you’ll learn about: 

• Features of the Patient Set Editor 
o Overview of the Patient Set Editor 
o Links to Data Pages 
o Menus in the Patient Set Editor 
o Supporting Data Panel 
o Supporting Text 
o Treatment Data 

• Processes 
o Editing Data Fields 
o Polishers 
o Linking Records to a CTC 
o Comparing Consolidated Data to Source Data 
o Moving Records to a Different Patient Set 
o Using Tools to Edit Address Data 
o Geocoding Tools 
o Adding Sequence Placeholders 
o Deleting a Linked Record 

• Saving Changes 
• Undoing Changes 
• Printing 
• Keyboard Shortcuts 
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Overview of the Patient Set Editor 
There are three panels, from left to right, in the Patient Set editor.   

• Links to data pages are in the left panel.  These include links to CTC pages.  Each CTC 
contains the data for a cancer diagnosis.  CTC was originally defined as an acronym for 
cacner/tumor/case but is often understood to mean the consolidated tumor case.    

• Data fields are displayed in the center panel. 

• Supporting Data are shown in the right panel.  Supporting Data include text, image files, 
system alerts, edit failures, comments from registry coders, claims data, pharmacy data, 
and other linkage data. The supporting data available varies by patient. 

 

The title bar shows the Patient Set ID and tools for consolidating data. Immediately below the title 
bar is a header with a summary of patient data.  The data displayed in title bar and header are: 

• Patient Set ID – PAT-00010200 in the screen shot.  The eight-digit segment of the ID is 
NAACCR item #20. The full ID is stored in the display_id field of the patient table. 

• Demo Info – This popup provides a quick method to compare the patient’s name and other 
identifiers between the Patient Set and source records. Use this popup to confirm that all 
source records are linked to the correct Patient Set. 

• Record Linkages – Use this popup to change or confirm the CTC linkage of source records. 

• Text – Open this popup to view supporting Text in a separate, movable window.  The data 
displayed in this popup are the same as those shown in the Text tab on the right panel. 

• View Source Data – This link controls the display of data in the center panel.  By default, 
only the consolidated data items are displayed. Click View Source Data to compare the 
values of consolidated data items to values in source records. 

• Header - Patient identifiers (name, SSN, sex, race, DOB, date of last contact, and vital 
status) are always shown. The second line of the header is a summary of CTC data.  CTC 00 
indicates the sequence number.  It is followed by site-laterality, histology/behavior, and 
date of diagnosis.  Other labeled fields may also be shown such as Type of Reporting 
Source, state address at diagnosis, region, and flags indicating whether the CTC is SEER or 
NPCR reportable.  The CTC data summary is shown on every CTC data page; it is shown on 
all data pages if there is only one CTC in the Patient Set (not including deleted CTCs).  
Note:  Record data items are shown in the header when viewing a source record. 
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Links to Data Pages  
The left panel contains links to pages containing Patient Set and source record data.  If you have a 
smaller monitor, you may use the double arrows next to Demo Info in the title bar to hide or show 
the left navigation.  When hidden, a menu icon is show so that you can access the page links.  

Use the links in the left panel of the editor to:  

• Go to a data page.  Clicking CTC will take you to 
the main CTC page and expand the CTC menu.   

• Review or create an Abstract Facility Lead 
(AFL) to indicate that an abstract is needed (see 
Chapter 21: Managing Abstracting Assignments). 

• Review the Patient Set’s Audit Log.  Changes 
made to data items are listed in the audit log.  

• Review or submit a request to the reporting 
facility for Follow-back information. 

• View Images.  These may include pathology 
reports or other documents that were originally 
recorded on paper and scanned. 

• View Special Studies to which this patient is 
assigned.  You may also add or remove the 
Patient Set from a special study. 

• Access records that need to be consolidated 
(listed under the Pending heading).  

• View records that have been fully consolidated (listed under the Consolidated heading).  

Menus in the Patient Set Editor 
The three-dot menu icon is used throughout SEER*DMS. Click 
the menu icon to the right of the Patient Set ID to open the 
Patient Set menu.  

The items on the menu vary according to the page that you 
are viewing.  This shows the menu when viewing the 
Demographics page. 
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Supporting Data Panel  

 
The right panel of the editor displays Supporting Data. The Supporting Data tabs may include:   

• System messages and task-specific instructions on the Alerts tab.  

• Text fields stored in the Patient Set and source records.   

• Edits that are failing for data items in this Patient Set.  These include edits maintained by 
standard setters (SEER, NAACCR, NPCR, etc) and edits defined by the registry. 

• PDF files and other digital image files, if available, are displayed on the Img (image) tab. 
These may include scanned versions of paper pathology reports and other documents. 

• The Cmt tab contains comments.  These include notes added by registrars and messages 
generated by SEER*DMS (there is an option to hide auto-generated system messages). 

• Claims and pharmacy data are displayed on the Rx-Tx tab.  This tab can be used to add 
treatments based on these data.  This tab is only visible if these types of data are available 
for this patient set and you have the system permission required to view these data.  

• Physician reports imported in CDA format are displayed on the EHR (electronic health 
record) tab. 

• Reference data are displayed on the Ref tab.  This tab is only shown if reference data 
sources are defined in your system.  Reference data sets may be defined by registry IT staff 
and may include data for the patient that are stored in the SEER*DMS database or data 
stored in external data sources.  External linkage data are sometimes shown in the Ref tab. 

Supporting Text  
View text fields in the right panel of the Patient Set editor; or use the Text link in the title bar to 
open a separate window showing the Text.  If you use a separate window, then you must use the 
Text link to refresh the contents each time you open a new Patient Set.   

Text fields are stored in source records and, to a lesser extent, may also be stored in CTC fields. 
Use these controls to change the display of text: 

• Display Text From – Use this menu to view text on a specific record or text from one CTC 
while editing another. A user preference determines the default setting of this menu. 

• Hide non-values – Check this to hide text fields with values like “NA”, “No Text”, “None”, 
etc.  You can view the terms considered to be non-values by clicking the Hide non-values 
label.  The terms are defined in a registry configuration parameter (text.non.value).  To 
make changes to the list, submit a request to the SEER*DMS Technical Support team. 

• Lock – The Text tab is updated each time you change pages unless it is Locked.  The tab is 
updated when you go to another record or CTC.  The text popup window does not adjust 
when you change pages; you must manually select a new page in the text window. 

• Group Text By – This controls the way the text fields are organized.  Select By Field to see 
text from all records for the first field; followed by text from all records for the next field.  
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For example, you could read the Clinical History from all facilities.  The other options are to 
group the text fields By Record or By Facility.  Recommended:   SEER*DMS automatically 
hides duplicate text fields if you display By Field. 

• Included Record Types – Use this option to limit the display by record type, for example, 
select HL7 to limit the display to text from electronic pathology reports.   

 

Treatment Data Pages 
There are 3 types of treatment data pages: 

• Summary TX – Summary treatment fields are stored at the CTC level.  These are the 
consolidated treatment values.  SEER*DMS calculates the values, but you may over-ride the 
calculations. 

• TX – A TX is the registry’s copy of treatment both given and reported by one facility.   
These data are typically copied from the RX hospital fields on a NAACCR abstract record. 

• TXr – A TXr is the registry’s copy of treatment given at one facility but reported by a 
different facility.  Two different facility IDs will be shown on a TXr data page.  The facility 
that treated the patient is often unknown. When treatment data are incorporated into a CTC 
from a NAACCR abstract record, both TX and TXr data pages are created if there are 
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treatment data in the NAACCR summary fields that are not included in the NAACCR hospital 
fields.  The TXr data are built from the additional data in the Summary TX fields on the 
NAACCR abstract. 

You may modify the CTC Summary TX data fields; however, it is typically better to modify the data 
on the TX and TXr pages.  SEER*DMS will automatically re-calculate the Summary TX values.  The 
standard way of maintaining treatment data is described below. 

1. SEER*DMS copies data from a NAACCR abstract record into TX and/or TXr data pages.  This 
happens when the record is linked to the CTC. 

2. A CTR at the registry corrects coding errors in the TX and TXr data pages.  The original 
values on the abstract are retained for reference. 

3. SEER*DMS calculates the Summary TX values based on the TX and TXr data.  Refer to the 
CTC Summary polishers on the Help>Polishers page to view the summarization logic. 

4. The registry CTR may over-write the Summary TX values, if necessary.   To prevent 
SEER*DMS from re-calculating, the CTR must set a review flag. There is a review flag for 
each section which stops the polisher from re-calculating the fields in that section (Surg 
Rev, Radtn Rev, and Systemic Rev). 

Working with Treatment Data 

The links to the Treatment Data Pages in this Patient Set are: 

Course 1 – click this link to view Summary TX data.   

TX 1 – treatment reported by and provided at FAC-1000. 

TXr 1 (9999~1000) – treatment reported by FAC-1000 but 
provided at FAC-9999.   FAC-9999 is the unknown facility in this 
registry.   FAC-1000 reported that the patient had treatment at 
another facility, but the facility name was not provided. 

 

 

 

There are two screen layouts for viewing treatment data.   You may view one TX page at a time 
(Page Mode) or you may view all data for a course of treatment at once (Comparison Mode).    
Your account preference determines which mode is shown by default.   

The screen shot below shows the Summary TX data in Page Mode.   Only the Summary TX data 
fields are shown.  You may use the chevrons to expand or collapse each section, or use the Expand 
or collapse sections with the chevrons, or the Show All or Hide All links to expand or collapse all 
sections.  
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Clicking Compare TXs above will switch the display.  The screen shot below shows the same 
Summary TX data, but in Comparison Mode.   The Summary TX values are shown in the first 
column.  The other columns contain the TX and TXr data.    

 

You may edit all fields in the Page or Comparison Mode.  To edit a data item, click the edit link for 
the TX column. If you wish to delete a TX page, click a delete link at the bottom of any section.   
Be aware that clicking a delete link will delete the full TX or TXr page.  In some registries, the data 
page is permanently removed when a treatment procedure is deleted.  In other registries, the page 
is marked as deleted and the data are excluded from the summarization polisher.  The permission 
pat_tx_delete is required to delete a TX or TXr.  
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You may limit the comparison to TX and TXr data from one facility.  This allows you to manually 
consolidate the data for a single facility into one TX.   Use the left navigation to open a TX page 
from that facility.  Click Compare FAC-NNNN TXs (upper right).   TX and TXr data pages for the 
same facility will be displayed. 

 

Editing Data Fields 
You may type a value into the field or select a value from a pick list (or lookup). To open a field’s 
lookup, click the drop-down arrow or go to the field and click ALT-L. 

You cannot modify read-only fields set by the system.  Read-only fields are displayed in gray boxes 
to show that the edit box is disabled.  Fields that can be changed are shown in white edit boxes. 
Read-only fields are set by polishers, auto-consolidation rules, and other system algorithms. In this 
screen shot, NAPIIA is a read-only field and the Race fields are fields that can be modified. 

 
 
Use the search box to find a value in a lookup that has too many values to display. You can enter a 
code (like C048) or text (like “overlapping”).  Items that match your search terms will be listed.  
Use your mouse to select a value or use the arrow keys to go to a value and press Enter. 

 
 

Click the field’s label to view documentation.  Registry-specific instructions are shown first.  If the 
field is a NAACCR item, the Info tab includes text from the NAACCR coding manual. 
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You may enter a comment related to the field’s value in the Comment box.  All changes and 
comments will be displayed in the Patient Set audit log and audit log. 
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The Mappings Tab shows technical documentation for the field.  

• Use Java Path when referring to the field in Mass Change imports and workflow scripts.  

• Use database name in SQL queries.   

• Java Type and Database Type show field length and type.   

• If Updatable is false, the field cannot be modified via Mass Change (this does not indicate 
whether changes can be made via the editor).   

• Nullable indicates whether the field can be blank. 

• A Lookup is listed if there one associated with the field.  The lookup may be a database 
table, or it may be a query defined in the lookups.xml system file. 

Polishers 
A polisher is a function in SEER*DMS that sets the value of a field based on the values of other 
fields (“trigger” fields).  A polisher executes each time a trigger field changes.  All changes made 
by polishers are listed in the Audit Log (designated by a [p]).  The fields that trigger the polisher 
and the polisher’s algorithm are documented on the Polishers help page.    

The Patient Set menu allows you to Force Polish, that is, run all polishers despite the fact that the 
trigger fields were not changed.  This feature should be used with caution.  All polishers will 
execute and, therefore, there may be unexpected changes in fields unrelated to your editing task.  
If you use Force Polish, you must carefully review the list of changes displayed when you save the 
Patient Set.  If an undesirable change was made to the data, you should either correct the data 
manually or reverse the changes before saving (see the Undoing Changes section of this chapter). 
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Linking Records to CTCs 
Requires system permission: pat_edit  

Linking and unlinking records may be done from the record menu or with the Record Linkages tool.  
If a record is linked inappropriately, review the relevant Patient Set and/or CTC data fields to 
determine whether you must also modify some data fields manually.  Use the Audit Log as a 
reference.  You may also want to print the Patient Set prior to changing the links.   

After completing your review, either use the record’s menu or the Record Linkages tool to modify 
the record’s link.  The following instructions involve the use of the record’s menu. 

1. Open the record in the editor and click the record menu icon.  

a. To completely disassociate the record from this Patient Set, select Unlink.  The record 
will be sent into the workflow at the point of matching.  It will follow the workflow route 
designated for a record of its type. 

b. To link the record to an existing CTC, select the appropriate CTC from the Move To sub-
menu (sequence number is displayed for each CTC listed in the menu). 

c. If you wish to use the record to create a new CTC, select New CTC from the Move To 
sub-menu.  This menu item will not be available if the system is unable to build a CTC 
from a record of its type.  If you are creating a CTC from a non-abstract record, you 
should perform the appropriate Casefinding and Death Clearance processes prior to 
creating a new CTC from the record.  

d. To link the record at the Patient Set level, select Patient from the Move To sub-menu.  
If the pending record is not an abstract record and is for a new CTC, you may wish to 
link the record at the patient level and defer creating the new CTC until an abstract is 
received.  Later, when the abstract record is received and used to build the new CTC, 
you can link this record to that CTC.  This will minimize the level of effort required to 
consolidate the data for the new CTC. 

2. Once the record’s link is moved, the new linkage will be indicated in the white box in the 
record navigation: 

a. If the record is linked to a CTC, “CNN” will be displayed.  This indicates that the record is 
now linked to the CTC that has a central sequence number equal to NN.  SEER*DMS 
attempts to set the sequence number appropriately, based on the central sequence 
number coded in the record and the dates of diagnosis on CTCs in the Patient Set.  If 
you have multiple CTCs with the same sequence number, you should review the CTCs 
and manually over-ride the sequence number polisher by setting the Auto-Seq field 
(refer to the help text for the Increase CTC Sequence Number polisher on the Polishers 
help page). 

b. If the record is linked at the patient level, P will be displayed. 

c. If the record is unlinked, an X will be displayed.   

3. Perform a thorough review of the Patient Set data, including the data pages of all CTCs that 
were affected by the change.  You must determine whether any admissions or treatments 
need to be manually deleted from the original CTC.  If you have unlinked a record 
completely, you should verify that the patient’s follow-up information has been modified 
appropriately. 
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Comparing Consolidated Data to Source Data 
A link in the upper right of the main data panel allows you to toggle the current page from one 
view to another.  You can View Source Data or View Consolidated Data.   The Source Data View 
enables you to compare data fields on records with the fields in the consolidated Patient Set, and it 
provides a convenient method to copy values into the appropriate Patient Set fields.   

The Source Data Viewer is available on pages that contain data consolidated from multiple records.  
Therefore, it can be used on the Demographics, CTC, and Staging pages.   The Summary TX page 
contains data summarized from other pages within the CTC; it is not consolidated directly from the 
records.  The “Compare TXs” view on the Course Page allows you to compare TX, TXr, and 
Summary TX values.  

Instructions for using the Source Data View to consolidate data are included in Chapter 12:  
Consolidating Data. 

Deleting a Linked Record 
Requires the rec_delete permission for each record type 
(10 total permissions) 

Deleting a record must be done with care.  When deleted, 
a record is completely and permanently removed from the 
database.  To delete a linked record, open the record in 
the Patient Set editor.   Check the information at the top 
of the page to be sure that you are viewing the correct 
record.    

To delete a linked record: 

1. Open the record in the editor.  The record will be 
displayed in read only mode. 

2. View the record header at the top of the page and 
confirm that it is the correct record. 

3. Open the record menu and select “Delete Record”.  
This menu item will not be available if you do not 
have the system permission to delete the record 
type. 

4. Save changes for the deletion to take effect. 

5. Perform a thorough review of the Patient Set data, 
including the data pages of all CTCs that were 
affected by the change.  You must determine 
whether any admissions or treatments need to be manually deleted from the original CTC.  
You should verify that the patient’s follow-up information has been modified appropriately. 
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Using the Geocoding Tools 
There are special tools in the SEER*DMS Patient Set editor for consolidating and editing addresses.  
These can be found with the Address fields.  

When a Patient Set address is changed, SEER*DMS submits the address to the Texas A&M, 
NAACCR, NCI Geocoding Service called AGGIE.  The geocoder will check to see if it is a valid street 
address for the city and zip.  SEER*DMS sets several variables using the AGGIE results (county, 
census tract, latitude, longitude, and other geo-spatial data items).  

Click “View AGGIE Data” to view the geocoder results.  If the appropriate address is listed in the 
results then select the line to set fields based on that address.  The data items that are geo-coded 
in your registry are listed in the Census Tract polisher documentation on the Polishers Help page.  

Click the “View Source Record Addresses” link to view all addresses in Patient Set and source 
record fields. The Address Review flag indicates whether an address has been manually reviewed.   

Saving Changes 
Use the steps below to save changes to a Patient Set.  If you are completing a Consolidate task 
then there will be options not shown below (refer to Chapter 12:  Consolidation).    

To save changes to the Patient Set: 

1. Click Save or press Alt+S. 

2. Review the list of changes.  These will include changes that you entered and changes made 
by SEER*DMS polishers, auto-consolidation rules, and other algorithms. 

3. You may enter comments to document your changes.  Use the Comments box above the list 
of data changes to enter a general comment.  Or enter a comment to document a change 
made to a specific field by clicking add in the Cmt column next to the field.  Your comments 
will be stored and displayed in the Patient Set’s audit log 

4. Save your changes: 

a. To save and continue editing this Patient Set:  click the Save button or press Alt+S. 

b. To save and exit the editor:  click Save & Exit or press Alt+E.  Note:  The keyboard 
shortcut for Save & Exit only works from the Review Changes page.  

Undoing Changes 
You may use the Undo Changes menu item (or press Alt+U) to undo all unsaved changes by 
reloading the Patient Set from the database.  Changes that you saved will not be undone.  All 
saved changes are documented in the Audit Log.  If you need to reverse saved changes, manually 
edit the fields, and enter the original values as noted in the Audit Log. 

Printing 
You may use the Print menu item (or press Alt+P) to open a print preview window.  Checkboxes 
will be displayed next to each section and all sections will be checked by default.  Uncheck the box 
next to each section that you wish to exclude from the printed copy.  Select File > Print from your 
browser menu.  
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Keyboard Shortcuts 
SEER*DMS supports the keyboard alternatives for many menu items 
and buttons.  Select Help > Shortcuts or press F1 to view the list 
of shortcuts available for the current page. 
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Viewing the Logic of Integrated Edits 
In the Patient Set or record editor, you can view documentation for any failing edit.  On the edits 
tab, click the information icon  next to the Edit ID.  Click on the Documentation tab to view 
documentation available for the edit.   To view the source code, select the Definition tab.   
Documentation is available for all SEER edits and many SEER-Extended edits.  Documentation for 
registry-specific edits will be displayed, if available. 

See the Chapter on Edit Errors for more information on edits. 

 

 

 

 

 

 

Visual Editing 
Quality control of new data involves a visual review of data fields, regardless of whether edits 
failed.  Visual editing is a quality control process that involves comparing coded fields to supporting 
text fields.  In SEER*DMS, this process is done when a registrar completes a Consolidate or 
Resolve Patient Set Errors tasks.    

The Visual Editing flag on the CTC page is set to “Needs review”, per registry rules.  If the registry 
has a policy of visual editing 100% of new cases, then the flag will be set to “Needs review” when a 
CTC is built.  If the registry’s policy is to require visual editing when standard-setter edits are 
failing, then the flag will be set accordingly.  In some registries, the visual editing flag will be reset 
to require a review whenever an abstract is linked to the CTC. 

When visually editing a case, compare the coded fields to the supporting text fields.  Work through 
each page of the CTC, including Staging, Facility, and Course pages.  When completed, set the 
Visual Editing Flag to 1 (Reviewed).  The case may remain in the worklist if other edits persist, or if 
the case has not yet been consolidated. 

Identifying and Removing Duplicate Patient Sets  
The Duplicate Patient Set task is executed each night to identify Patient Sets that may be 
duplicates.  It uses a registry-specific matching algorithm documented on the Matching help page.   

The nightly task only checks Patient Sets modified on that day.  A Patient Set is matched against 
the database if one of the fields used in the matching algorithm was updated or the Patient Set was 
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created that day.  The system task can also be run across the entire database.  This is done when 
a registry first starts using SEER*DMS and when the matching algorithms are updated. 

The matching algorithm is also executed each time the Patient Set editor is opened and when the 
Patient Set is saved. If a possible match is found, an Alert is displayed in the right panel and a 
warning is displayed on the save page.  The intent is to prevent duplicate Patient Sets from being 
created.  It is much more time consuming to combine existing duplicates than to prevent.  

If the matching algorithm falsely identified a Patient Set as a duplicate, click Not Duplicate – Set 
Match Status and indicate that it is a false positive match. Set the Action field to “Not a Match”.  
The two Patient Sets will no longer be identified as a pair of potential duplicates when the nightly 
task is executed.  

If two Patient Sets exist for the same patient, follow the steps below to consolidate the data into 
one of the Patient Sets and delete the other. 

1. Select a Patient Set to retain. 

2. Move source records from the unwanted Patient Set to the other Patient Set. 

a. Verify that the unwanted Patient Set is open in the editor. 

b. For each record listed in the Consolidated record section of the navigation box: 

i. Click the record in the navigation to go to that record. 

ii. Select Move To > Different Patient Set from the record’s menu. 

iii. Enter the other Patient Set ID (the ID of the Patient Set that you are keeping).   

3. Mark the unwanted Patient Set as deleted: 

a. Click Demographics in the Patient Set’s section of the navigation box and open the 
Patient Set menu.  

b. Click Delete Patient Set.  The Patient Set and all of its CTCs will be marked as deleted.  
This is a reversible delete.  

4. Save your changes to this Patient Set, enter a reason for deletion, and click Save and Exit. 

5. Verify that each record that was unlinked from the deleted Patient Set has been linked to 
the retained Patient Set. 

6. Once you have linked and consolidated data from all available source records, you must 
incorporate any data from the deleted Patient Set that was not loaded from a record.  This 
includes data that was migrated and data that was entered manually.  Even though the 
Patient Set was deleted, you may open it in the Patient Set editor to view or print the data 
or audit log.  If you wish to view both Patient Sets, use the browser’s controls to open two 
windows or tabs.  

Creating and Completing Review Tasks 
A Review Task is a manual worklist task created by one user for another user.  For example, you 
could create a review task when you need a manager or lead editor to review an unusual case.   

To create a Review Task:    

1. Select Create Review Task from the Patient Set menu.   

2. Select a user in the Assign To drop-down list. 

3. You may assign one worklist Flag to the task and enter a Subject, if appropriate. 
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4. Enter Instructions and click OK.   

To complete a review task: 

1. Access the task from the Worklist and review the instructions provided on the Alerts tab. 

 
2. Review the data, make any necessary changes and click Save.   

3. Enter comments stating that you reviewed the data and provide any information that you 
think may be useful.  Your notes and the original instructions for the task will be 
permanently recorded in the Patient Set audit log. 

4. If you have completed the review, click Close the task on Save & Exit in the Workflow 
Options section.  If you wish to keep the task open in your worklist, deselect this checkbox. 

Creating and Completing Quality Control (QC) Tasks 
Quality Control tasks can be used to perform quality control on a subset of records or Patient Sets.  

To create QC tasks: 

1. Use the data search tools (View>Data Search) to identify a subset of records or Patient Sets 
to include in the batch of QC tasks. 

2. Click on the Actions Menu and select Create QC Tasks. 

3. You will be prompted to provide instructions for the coders who complete the tasks. You will 
be able to assign the tasks to another user, assign them to your own account, or leave the 
user field blank to create unassigned tasks.  If appropriate, you can set a worklist flag 
and/or assign a subject to the QC project. You may also set the parameters of the tasks in 
the Parameters tab.  
 



The Patient Set Editor  4/18/2022 11-18 

 

4. To complete a QC task that is assigned to you, click on the task in your worklist.  The Alerts 
panel will display the instructions for the QC task. Make any necessary changes to the 
record or Patient Set. 

5. To close the QC task, click Save.  In the save screen, check the box for “Close the task on 
Save & Exit”. You may optionally enter a comment.  Click Save & Exit. 

Comparing Abstract Records 
The Patient Set Editor includes a tool to compare one abstract record to another.  You may use this 
to identify duplicate records.  To compare records, open a consolidated abstract record in the 
Patient Set editor.  Click the Compare Records at the top right of the main data panel.  You may 
use this to compare a Health Record to other Health Records; or to compare NAACCR Abstract, 
NAACCR Modified, and NAACCR Casefinding records to each other.  In the example below, a 
NAACCR Modified record linked at the patient level is compared to all candidate records in the 
Patient Set. As determined by registry algorithms, a record will not be considered as a candidate if 
it does not match the focus record on a standard set of fields such as facility, site, histology, or 
laterality.   

 

 



The Patient Set Editor  4/18/2022 11-19 

Submitting Follow-back to Facilities 
Requires system permission: pat_edit and fb_initiate 

In SEER*DMS, a request for follow-back information is referred to as a “follow-back need”.   If you 
determine that additional information must be obtained from the reporting facility, you should 
submit a follow-back need.  Select Add Follow-Back from the Patient Set menu.  

Periodically, a manager will review, edit, and send the follow-back requests to a physician or other 
representative at a facility.  Subsequently, the manager will process the facility’s responses.  

You will receive an e-mail when a response to your request is processed and the follow-back need 
is closed.  You or another staff member may update data fields based on the new information.  As 
determined by registry policy, one staff member may be responsible for processing all follow-back 
responses, or the information may be given directly to the staff members who entered the needs.   

If you suspended a task pending the receipt of follow-back information, you must re-open and 
complete the task to allow the data to move forward in the workflow.  You must either make 
changes to data fields based on the new information or verify that the appropriate changes were 
made.  If you completed the task but need to update the Patient Set with the new information, use 
the Patient Lookup to search for the Patient Set.   
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